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S T e S R PR
SEMICONDUCTOR ™

MM74HCO0
Quad 2-Input NAND Gate

General Description

The MM74HCO00 NAND gates utilize advanced silicon-gate
CMOS technology o achieve operating speeds similar (0
LS-TTL gates with the low power consumption of standard
CMOS integrated drcuits. All gates have buflered outputs.
All devices have high noise immunity and the ability to

September 1983
Revised January 2005

Features

B Typical propagation delay: 8 ns

B Wide power supply range: 2-6V

B Low quiescent cumrent: 20 pA maximum (74HC Series)
B Low input current: 1 pA maximum

drive 10 LS-TTL loads. The 74HC logic family fs functon-
ally as well as pin-oul compalible with the standard 74LS
logic family. All inputs are protecled from damage due to
static discharge by intemal diode clamps lo Vee and

ground.

B Fanout of 10 LS-TTL loads

Ordering Code:

Package
Number
M14A
M14A
M14D
MTC14
MTC 14

Orcler Number Package Description

MM74HCOOM
MM74HCOOMX_NL
MM74HC00SJ
MM74HCOOMTC
MM74HCOOMTCX_NL

14-Lead Small Outline Integrated Circuit (SOIC), JEDEC MS-012, 0.150° Namrow

Pb-Free 14-Lead Small Outline Integrated Circuit (SOIC), JEDEC MS-012, 0.150" Narrow
Pb-Free 14-Lead Small Outline Package (SOP), EIAJ TYPE II, 5.3mm Wide

14-Lead Thin Shrink Small Outline Package (TSSOP), JEDEC MO-153, 4.4mm Wide
Pb-Free 14-Lead Thin Shrink Small Outline Package (TSSOP), JEDEC MO-153, 4.4mm
Wide

N14A | 14-Lead Plastic Dual-In-Line Package (PDIP), JEDEC MS-001, 0.300" Wide

N14A | Pb-Free 14-Lead Plaslic Dual-n-Line Package (PDIP), JEDEC MS-001, 0.300" Wide

Devicas also avaiadia In Tape and Ree! Specty by appending the suffix letter X" 1o the ordenng code.
Pb-Froe package per JEDEC J-STD-0208

MM74HCOON
MM74HCOON_NL

Connection Dlagram Leglc Diagram

g [ S SRS

Pin Assignments for DIP, SOIC, SOP and TSSOP

(I VR Y Y4 B3 A Y3
1w 1 12 |n

© 2005 Fairchid Semiconductor Corporation www.fairchiidsemi.com




* Package Options Include Plastic ‘‘Small SN54107, SNS4LS107A . . . J PACKAGE
Outline’” Packages, Ceramic Chip Carrlers, - 3‘;74"”\7 ---N ';!AmGtKAGE
and Plastic and Ceramic DIPs SN7415107A .. .D O ¢

(TOP VIEW)
* Dapendable Texas Instruments Quality and

Reliability

description

The 107 contain two indapendent J-K flip-fiopa with
individual J-K, clock, and direct clear inputs. The 107
is a positive pulse-triggered flip-flop. The J-K input data
is loaded into the master while the clock is high and
transferred to the slave and the outputs on ths high-to-
low clock transistion. For thess devices the J and K inputs
must be stable while the clock is high.

SN54LS107A . . . FK PACKAGE
(TOP VIEW)

The 1L.S107A contain two independent negative-edge-
triggered flip-flops. The J and K inputs must bs stable
prior to the high-to-low clock transition for praedictabls
operation. Whan the clsar is low; it overrides the clock
and data inputs forcing the Q output low and the Q
output high.

The SN54107 and the SN54LS107A sare characterized
for operation over the full military temperature range of
~55°C to 125°C. The SN74107 and the SN74LS107A
5 . 100 QO 5 ¥
are characterized for operation from 0°C to 70°C. NZ 2N 4

(&)
O o~

9 10 111213
1S e ¥ e 74

NC - No Internal connsction

‘107
FUNCTION TABLE

| ouTPUT J
Q

K
X
L
L

L
Qo
H
H L

H | TOGGLE

‘LS107A
FUNCTION TABLE

INPUTS OUTPUTS j
L CLK J Q a

L X L H

H

C

L

' Qo Qo
H L
L M
TOGGLE
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description

The ‘48A, ‘47A, and 'LS47 feature active-low outputs designed for driving common-anode LEDs or incandescent
indicators directly. The ‘48, ‘LS48, and 'LS49 featura activa-high outputs for driving lamp buffers or common-cathode
LEDs. All of the circuits except 'LS49 have full ripple-blanking Input/output controls and a lamp test input. The ‘LS43
circuit incorporates a direct blanking Input. Segment Identification and resultant displays are shown below. Display
patterns for BCD input counts above 9 are unique symbols to authenticate input conditions.

The '48A, ‘47A, '48, 'LS47, and 'LS48 circuits incorporate automatic leading and/or trai@jg-ad'ge zero-blanking control
(RBI and RBO). Lamp test (LT) of these types may be performad at any time when the BI/RBO nods is at a high level.
All types (including the ‘49 and 'LS49) contain an overriding blanking input (BI), which can be used to control the

lamp intensity by pulsing or to inhiblt the outputs. Inputs and outputs are entirely compatible for use with TTL logic
outputs.

The SN54246/SN74248 and ‘247 and the SN54LS247/SN74LS247 and 'LS248 compose the 5 and the 9 with
tails and were designed to offer the designer a choice between two indicator fonts.

7 8 10 1 12 13
NUMERICAL DESIGNATIONS AND RESULTANT DISPLAYS

= E b )
E H_J —_{ '
2 6

3 5

SEGMENT
IDENTIFICATION

‘46A, ‘47A, 1.S47 FUNCTION TABLE (T1)

DECIMAL

— OUTPUTS
OR BI/RBO?
FUNCTION [

|

ps )
o]

a b c d °
ON ON ON ON ON
ON ON OFF
ON ON ON ON ON
ON ON ON ON | OFF ON
ON ON | OFF | OFF ON
ON | OFF | ON ON | OFF
OFF | ON OoN ON ON
QN CON JiN | OFF | OFF
ON ON ON ON ON ON
ON ON ON | OFF | OFF ON
OFF | OFF |OFF | ON ON | OFF | ON
OFF | OFF | ON ON | OFF |OFF | ON
OFF | ON |OFF | OFF | OFF | ON ON
ON |OFF |OFF | ON | OFF | ON ON
OFF | OFF |OFF | ON ON ON ON
OFF | OFF |OFF | OFF | OFF | OFF | OFF
OFF | OFF |OFF [ OFF | OFF [OFF | OFF

OFF | OFF [OFF | OFF | UF¢ jure | UFr
lON Ion Low ‘ ON lON lONJ ON

NOTES 1. The blanking ‘input {B1) must be opan or held at a high logic level whan cutput functions O through 15 are desired. The
rippla-blanking input [ABI1) must be open or high if blanking of 3 decimal zaro is not dasired.

Whan a low logic laval is applied directly to the blanking input {B1), all segment outputs are off regardiess of tho level of any
othar Input,

X

‘ol ol o < el -

o3 ool O i (= Ol o

Tir ¢ Cre s e ro

Tr

XIx X % X[Xx X X X[X X X X|X X X

¥IXT EFETr- rFlX T rr

-

r

RBI w
LY l L X X

H = high level, L = low leve!, X w irrelevant

X

2

3. Whan ripple-blanking input (RB1) snd inputs A, B, C, and D aro at 8 fow laval with tha lamp test input high, all segmant putpuls

9o off and tha ripple-blsnking output (HBO) goss to a low level (responsa condition).

Whan the blanking [nput/ripple blanking output (B1/ABO) is opan or held high and a low is spplied 10 the lamp-tast Input, al!
sagmaent outputs are on,

a.

"B_T/H 80 is wire AND logie sarving as blanking Input {BT) and/or ripple-blanking output (RBO).

VY S




SN5446A, '4TA, '48, SNSALS4T, 'LS48, 'L SA49
SN7446A, '47A, '48, SNT4LSA47, 'LS48, 'L S49
BCD-TO-SEVEN-SEGMENT DECODERS/DRIVERS

SDLS111 - MARCH 1974 - REVISED MARCH 1988

‘46A, '47A, 'LS47 48, ‘L8548

‘L849
feature featurs

feature

Open-Collector Outputs Internal Pull-Ups Eliminate
Drive Indicators Directly Nesad for External Reslstors

Lamp-Tast Provision Lamp-Test Provision

Leading/Tralling Zero Leading/Tralling Zero
Suppression Suppression

» Open-Collector Outputs
e Blanking Input

SNB448A, SN5447A, SN54LS47. 8NE448, SN64LS47, SN54L548 . . . FK PACKAGE
SNB4LS48 . .. J PACKAGE

(TOP VIEW)
SN7446A, SN7447A,
SN7448 ... N PACKAGE : o O
SN74LS47, SN74LS48 . .. D OR N PACKAGE OmZ> .

(TOP VIEW] 3 2 12019

LT 8 g
BI/RBO 17(] a
NC 18 NC
RBI ‘5le
Dijs 4] c
9 10111213

<NV ®D
Z 2
]

SN54LS49 ...J OR W PACKAGE SNG54LS49 . . . FK PACKAGE
SN74L549...D OR N PACKAGE (TOP VIEW)

(TOP VIEW)

vVce

f

g
a
b
c
d

10 1112 13

NC — No Internal connaction
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module full_adder (S, C, A, B, Cin);

output S, C;

input A, B, Cin;

assign S= A~B " Cin;

assign C=(A & B) | (A &Cin) | (B & Cin);

endmodule
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module full_adder (S, C, A, B, Cin);
output S, C;

input A, B, Cin;

assign {C, S} = A+ B + Cin;
endmodule
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module two_bit_adder (S, A, B);

output [2:0] S;

input [1:0] A, B;

wire C_b;

full_adder 10 ( S[0], C_b, A[0], B[0], 1’0 );
full_adder 11 ( S[1], S[2], A[1], B[1], C_b);
endmodule
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module d_flip_flop (Q, D, clk);
output Q;

input D;

input clk;

reg Q;

of




always @(posedge clk)
Q<=D;

(:endmodule

el 0diay a5 (BIBY L yg0ds o gy p odeQ g, A S oo ZBS 20 oo Giuled |y ool D OB o8 SO aali s
90 opl 09l o ggmalways  jews SG L asly Lol las g0 0,50 a0 O s G Qusly 45 WS oo i Sl 4 o)
s2ig 3l slaad 53 18l Yol pialys oo 0uiS (28 Yo les JareQ a1y Dladie 0ig Vb ad 12 )3 w0 lyad 155 oo b

23,5 Sl iSO ygo ol 4 Verilog oS el JEeQ 4D oud N0t e Lk wsd alxl

module d_flip_flop (Q, D, clk);
output Q;

input D;

input clk;

reg Q;

always @(negedge clk)
Q<=-D;

endmodule
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module d_flip_flop (Q, D, clk);
output Q;

input D;

input clk;

reg Q;

always @(posedge clk)

if (reset)

Q<=0;

else

Q<=D;

endmodule
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always @ (posedge clk or posedge reset)
if (reset)
Q<=0;

ov




else
Q<=D;
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module four_bit_mux (mux_out, mux_in, mux_control, clk);
output mux_out;
input [3:0] mux_in;
input [1:0] mux_control;
input clk;
reg mux_out;
wire mux_out_w;
assign mux_out_w = (mux_control == 2’b00) ? mux_in[0] :
(mux_control ==2’b01) ? mux_in[1] :
(mux_control ==2°b10) ? mux_in[2] :
mux_in[3];

always @(posedge clk)

mux_out <= mux_out_w;

endmodule

o509 (Jg Conl (G ST (29> w3 oo QL ]y 010 S5 (6399 Su g (295 Su 53959 ¥ a5 puSly (b Su VL sl )0
aS" odicdy y5 MUX_OUE W sl 4y e SO .50 (05 S SO 31 s plaS 2 g Wloaiicay yoi ools Jlazl (Bus)  Llop &0
ol 00l o0l was o ploul b yd jebas 1) 20 )laie aS SSIGN Hgws G 3l eolainl L MUX laesgs .ol MUX Jlaw (25,5
223 oo JoSad | el Sl ¥ jgws ol
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module four_bit_mux (mux_out, mux_in, mux_control, clk);
output mux_out;
input [3:0] mux_in;

input [1:0] mux_control;
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input clk;

reg mux_out;

always @(posedge clk)

case ( mux_control )

2’b00 : mux_out <= mux_in[0];
2°b01 : mux_out <= mux_in[1];
2’b10 : mux_out <= mux_in[2];
2’b11 : mux_out <= mux_in[3];
default : mux_out <= mux_out;
endcase

endmodule

mux_control ;I jlase o (gl 5 &S o0 S |, MUX_CONLIOl (05,9 Couxdg ouig YU ad ;o ;0 €ase jsws jl oolawl b YL asliy

Sie ) wsls mux_control 99,9 ,0CASE  jghws 0 ol S Jlade L 5l plaSae I 0105 o (25,5 g9, | el (5999

Slade MUX_oUt aSs! a0l salgs |yl default ise o sabaiig oS sl (il YU Luilael 2bzz L 1, mux_control

2,8 anless s )] Jlade 0,5 aslgs Laas |, 395 LB

module ram_interface (address_out, data, rnw, reset, clk);
output [15:0] address_out;

inout [15:0] data;

output rw;

input reset, clk;

reg [15:0] address_out;

reg rnw;

reg [15:0] access_address;

reg read_write_turn;

reg [15:0] data_in_register;
assigndata= (! mw ) ? 0: 16’bz;
always @(posedge clk)

if (reset) begin

address_out <= 0;

mw<=1;
end
else begin

if (rnw ) begin
data_in_register <= data;

access_address <= access_address + 1;

end
if (data_in_register == 16 hff0f)
mnmw <=~ rnw;,

014




if (1 rw)

rnw <=~ rnw;
end
endmodule
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module d_flipflop_2clks(clkl, clk2, d, q);
input clkl, clk2, d;

output q;

reg q;

always @ (posedge clkl or posedge clk2)
begin

g<=d;

end

endmodule
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ysd ol L 3l 5 ales 1,21,
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Status 2l
Module: | Progress 7% [ Time & |

@ Documentation

L-lx
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a8 bl |, File>New Project Wizard jskas ol gl 0,05 c0 & y90 Wizard G lawgs 15810 5 cpl 10 duaz 059, S ol

D9 (bledy; oyt B

enrasersnion |

The Mew Project Wizard helps vou create a new project and preliminary project settings, including the

following:

» Project name and directary

* Mame of the top-level design entity
* Project files and libraries

* Target device family and device
» EDA toal settings

*Y'ou can change the zeftings for an existing project and specify additional project-wide settings with
the Settings command [Assignments menu]. You can uge the various pages of the Settings dialog box
ta add functionality ta the project.

™ Don't show me this introduction again

< Back Nedt Finish Cancel

YoV S

Bed Hbled oz b oS SIS, Next as 35

New Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5] ‘ [T

‘what iz the working directory for this project?
IC:\aItera\quartusED |
what iz the name of this project?

[Fulade =]

‘what iz the name of the top-level design entity for this project? Thiz name iz case sensitive and must
exactly match the entity name in the design file.

[Fulader =]

Use Existing Project Settings ...

< Back Mex = Finigh Cancel

PV S

435 5l 5 L Top Level Jgsle o 5 o355 b Ygmne) o s 5L 55 955 035 4 bgapa oMbl 0,33 (6l (6 yomme 5
(g5

#¥




e
New Project Wizard: Add Files [page 2 of 5] [

Select the design files you want to include in the project. Click Add Al to add all dezian files in the
project directory to the project. Mate: you can always add design files to the project later.

File name: I[ _I Add... |
File: name | Type | Add Al |

Remowve

Froperties
Up

Do

il

Specify the path names of any non-default libraries. User Libraries. .. |

< Back Next = Finish

Cancel

B IS

P Dogo ol j0 wms oo bl sxlia 1) Jee )l Ceend ol o Wiizard sl aziils 5925 059, 4 0,5 adlal gl LB S
Loy ok conl )8 a8 slasl s g5 005 jalls (gom oyonty U 00,5 SIS 1) NEXE. o 5lad 059 a4 (30,5 a8lal (gly 09290 LB 0S

(Device:Emp7128SLC84-15 4 Family:Max7000s).0.5S <SS ) NeXt o g ol cad S50 511 098 0ols o1 s,

New Project Wizard: FamiE & Device Settings [page 2 of _ [

Select the family and device pou want ta target for compilation,

 Show in ‘teeailable device' list

Family:  |MAX7000% =

Target device
" Auto device selected by the Fitter

& Specific device selected in ‘Bvailable devices' list Speed gradsr  |Any ht
Core voltage: 5.0
¥ Show Advanced Devices

Fackage: Ay -

PFir count: Ay -

Available devices:

I ame | Macro... | -
EFM71285LC84-7F 128
EPM71285LC84-10 128
EPM71285L184-10 128 A
EPM712850C100-6 128
EPM712850C100-7 128
EFPM712850C100-10 128
EPM712850C100-15 128 s
Companion device
HardCopy II: ;I
[¥ Limit DSP & RaM to HardCopy || device resources
< Back Mext = Finish Cancel

Y S
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Lo Lol o les el casS eolaswl Third Party mMhaolay sbs 15806 5 5 Quatus 1 5 ogdle dles oo ST Wizard 5l coand ol jo
3 glaodS s 0SS 1) NEXE s oS o0 o0laiwl Quartus 11 Jls sla il 51 >l a4 > glacand plos gl p

..\....S &..15 ‘) Finish b}w‘s‘o ).QLb O).’?La.) «S.: B 0)5)4 (5‘)-’ OMrﬂL‘x" g_)LA.Ja.u

New Project Wizard: EDA Tool Settings [page 4 of _ [

Specify the other EDA, tools -- in additioh o the Quartus || softwars - used with the project.

[~ EDA design entry/synthesis tool; I LI

Format: I "I

™ Mot available

[ EDA simulation took I d

Format: I j'

[T Mot available

[~ EDA timing analysis took I LI

Format: I 'I

[~ Mot available

< Back Neat = Finish Cancel

V-V S

New Project Wizard: Summa &5 of 5] ]

“when wou click Finish, the project will be created with the following settings:

Froject directon:

C:/altera quartuskly
Froject name: Fulladder
Top-level design entity: Fulladder
MHumber of files added: 0

Mumber of uzer libranes added: 0

Device assighments:

Family name: b 70005

Device: EPR7I2B5LCE4-15
EDA taols:

Desigh entry/synthesis: <Mone>

Simulation: <Monex

Timing analysis: <Mone>

<Back | Hews [ Fnsh | Cancel

A-Y S
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Quar - Cifa

T T
Dﬁﬂ|§|$ﬁ.|ﬂﬂ‘k‘?“fﬁdd |
e XX AR EN AN R
Project E— fF
Entity
MAX7000S: EPM71285
------ # fulladder

” Ry Hierarchy | B Files | & Design Units |

Status x|
Module | Progress % | Tme & |

& Documentation

Lolx

ages

System )\ Processing )\ Extra Info )\ Inta )\ afarning )\ Critical " arning )\ Error & Suppressed /
EIMESS&QE tl ¥ I ILocation: =1 Locate I
For Help, press F1 [ m® | Idle Y |

-V s
Verilog Design Entry

I, Verilog HDL file . 5 File>New ,glais oyl glpee lo Quatus 1 l58le 5 il g Jae 4y 5L Verilog oS e 6l

g 3l Kl g site Lama b 0iS OK g b

S

Device Design Files | Other Files |

AHOL File
Block Diagram/Schematic File
EDIF File

SOPC Builder Sistem

WHDL Filer

0K I Cancel

VeV S
Awles ol 1 Verilog 4 35 Save Type As o 5 File>Save As LB 05 0,53 6l

7V




A4S ol |, Add File To Current Project a5 5 s oo File Name o (o1, L U

JJOPQ}M}A&J‘fsM&‘Q ‘) .)95 )JAJQ)BA.ASY[} ..\....S&..ls‘) Save

Slygiws 5l salise gl s pad 4 0l oykal 4 o Verilog by Sl jsiws Syntax 50 ,ew bl 4 OByl S

S bl | Edit->Insert Template>Verilog HDL LagSIl oy 5 eslatul g1y 0,0 49 153810 5 9,0 eoleVerilog

05950 Ko 4 BB (3,5 4L

Aulgi oo A L g asS SIS 1 File o s g 5l 00l jalls 5 0y U oS Sl | Assignment->Setting a3

a8 bl |, Project->Add/Remove Files in Project

sons-s 0 AT =

Category:

[
[

- General

mFiles

- ger Libraries [Curent Project]

- Device

7l Timing &nalysis Settings

H- EDA Tool Settings

|- Compilation Process Settings

H- Analysiz & Synthesis Setlings

|- Fitter Settings

- Agsembler

- Diesign Assistant

- SignalT ap Il Logic Analyzer
Laogic &nalyzer Interface

- SignalProbe Settings

/- Simulatar Settings

- PowerPlay Power Analyzer Settings

Select the design files you want to include in the praject. Click Add All to add all design files in the j
project directory ta the project.

File namne:

=

File name

o Add |
Add Al |

| Type |

Remove |
Up |
Doy |
Froperties |

V-V S

Lo 5ol plos. 05,5 o Lais g0 a3 (59, (gjlwodle BB g s BT 13810 5 10 04290 aliea slo 5l lawgs saisaisgs Verilog oS

ALl s sls ®

g oo Sy LLal b dr 69,15 asl SG Al

a5l g, Al b g awles bl 1, Processing - Start Compilation 435 LLLlS sl > sy

ol aalgs Lol Lms o a7 5 dl po 12 gz e 40 1) Jlye i JolS 158
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3929 Judo daplin (pl w)ld 0g2g JSGIL Uns =By pl ol 0gd o 00l lis aliBre sloplin 1 Lol oo Sl 0y o
sy it Sledbl (sl 258 0 pasine JKAI 8 50 4ol b dlas pliy 58 (59, SAS-)lgo b asilyion g anled oo ol | >

..\...:Lo.: &..lf ‘) Fl 9 oé}o.; ul.‘?h.s‘ ‘) raLn...’ "\"‘-"9"6"

@ Compilation Report - Flow Summary EI@

|5/=3 Compilation Report Flow Summary
B Legal Notice
- ¢&HEA Flow Summary
- <HEH Flow Settings Flow Status Successful - Sat Apr 18 23:39:44 2015
(48 Flow Non-Default Global S | Quartus Il Version 6.0 Build 178 04/27/2006 SJ Full Version
- ¢HEA Flow Elapsed Time Revision Name a
é Flow Lag Topdevel Entity Name fulladder
-5 Analysis 8 Synthesis Famity MAX7000S
-0 Fitter Device EPM71285LC84-15
[1-SH] Assembler Timing Models Final
[]--@D Timing Analyzer Met timing requirements ~ Yes
Total macrocells 1/128(<1%)
Total pins 6/68(9%)
o om k

VY-V S

aldl T oo 097 4 Silagsl & ygoas (155l saims ylis o, g .09 oo 00ls 5155 azes fLalS Jes pledl 5l am Guien

Y IP F O & o9l g9, SUS L 4 Processin> Compliation Report wbsesl b (jo,155 !

Quartus I - C:/Users/J

File Edit View Project Assignments Processing Tools Window Help
EECIE R X, eRB|(T(> T 2|08 B
Project Navigator ————————————— +[ x| “E At I @ Compilation Report - Flow ... | !
Entity Macr =y
MAX70005: EPM71285LC84-15 o
5....ebc Fulladder 1 I module fulladder (5,C,A,B,Cin);
@ Compilation Report - Flow Summary EI
@a Compilation Report Flow Summary
~&EHB Legal Notice
< T 3 ~&HER Flow Summary
H\erarchy] Filesl o Diesion Unilsl @% Flow Settings Flow Status Successful - Sat Apr 18 23:39:44 2015
&HER Flow Non-Default Global Se | Quartus Il Version 6.0 Build 178 04/27/2006 5J Full Version
Status ;lz_l SHER Flow Elapsed Time Revision Name a
Module Progress 3% | Time & ~EHE FlowLeg Topdevel Entity Name  fulladder
Full Compilation 00:00:18 -0 Analysis & Synthesis Famity MAX7000S
- Analysis & Synthesis 00:00:02 #-¢5(] Fitter Device EPM71285LC84-15
- Fitter 00:00:03 []--@D Assembler Timing Models Final
Assembler 00:00:10 []..ég Timing Analyzer Met timing requirements  Yes
Timing Analyzer 00:00:03 Total macrocells 1/128(<1%)
Total pins G/E3(9%) [
4| 1 r
@ Documentation
4| m | * a | T ] 3
:’:II i) Info: Longest tpd from source pin "a" to destination pin "c” is 15.000 ns o

i} Info: Quartus II Timing Rnalyzer was successful. 0 errors, 1 warning
‘&) Info: Quartus II Full Compilation was succeasful. 0 errora, 1 warning |

m | b

<

System )\Plocessing)ﬂ Eutra Info )\ Info )\ W arhing )\ Critical Warming )\ Ermar )\ Suppressed /
élMessage:Uof 51 ﬁl il ILocation: ;I Locate |
For Help, press F1 [ LN Idle NUM él

VoY S

ages
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Sy oolaiils o0 (slo LE g oy olaas (3155 ol yo Mo, o Cendd G o gy A4S ASl oo yiSu cpaiz Juld 1S ol
Analysis & il b Wgd oo 0dsi yiw Jes 3l o Ll Lawgs a5 alate SYolae aS01 L g canl ol jastine i,k (g5lwosly

g o o3y L Synthesis—>Equation

Tob ilwands

Coyle eas b Jlae gileand gl sleans (Il Quartuss Hogs slol gjlwanss Joe b FPGA gy, 7,k (silwosly 51 13
9 Lﬂb‘_;’>5).‘> U‘M 05..» ool )L\A ‘_gl.n (503)5 L o..\...m)l.’}u‘ Test Vector rQlJ lJ @Lbcs.n J&m w‘ ra)y 46)L9M ral.’}u‘ )‘ J.J 1agd

g a0 o 7yb oo (gjlwesly Jow a1y TeXt VECIOr: jludacds Luww. 33,5 adine gd sdud Cuwl o3V a5 A3l 05031 bl

Al oo s |y (29,5

I, Other File as; 5 File> New loul jelais oy . omles oo oolal Waveform Editor ;1 Quartus 11, Text Vector sl sl

A4S SIS, Ok Vector Waveform File bl Lo ol

o =

Device Design Files  Other Files |

AHDL Include File

Block Symbal File

Chain Dezcription File
Hewradecimal [Intel-Format] File
Logic Analyzer Interface File
kemor [nitialization File

SignalT ap Il File
Tl Scnpt File
T et File
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Symbol I=0 I=1 Description
AND Oxxx 8xxx AND memory word to AC
ADD Ixxx 9xxXX ADD memory word to AC
LDA 2XXX AXXX LOAD memory word to AC
STA 3XXX Bxxx Store AC in memory
BUN 4XXX Cxxx Branch unconditionaly
BSA 5XXX Dxxx Branch and save return address
CLA 7800 Clear AC
CLE 7400 Clear E bit
CMA 7200 Complement AC
CME 7100 Complement E bit
CIR 7080 Circulate right AC and E bit
CIL 7040 Circulate Left AC and E bit
INC 7020 Increment AC
SPA 7010 Skip next instruction if AC is
SNA 7008 positive
SZA 7004 Skip next instruction if AC is
SZE 7002 negative
HLT 7001 Skip next instruction if AC is
zero
Skip next instruction if E bit is
zero
Halt Computer
INP F800 Input character to AC
ouT F400 Output character from AC
SKI F200 Skip on input flag
SKO F100 Skip on output flag
ION F080 Intrupt on
IOF F040 Intrupt off
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C2o
C40*

C8o0*
C160*

VDD

VDD

VSS
VSS

D3

1N4148

RS-232 & mt9042

VCC
R34

ANJRK

MT9042C

aseg31

asegaz

asegad

aseg34

aseg35b

asegab

aseg3’/

asegad

aseg41

aseg42

u7

2

= cl4
g —

3
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C15

1uf

—Z
— 8 |

C1+
V+
C1-
C2+
Cc2-
V-

T20UT
R2IN

VCC 033

CON20A

GND STO0TX

T10UT SIO0RX

R1IN RX0

VCC

FOo* LLZ
aaa 3
aaa 4
aaa. 5
aaa 6
aaa 7
aaa 8
aaa 9
aaa 10
aaa 11
aaa
T4 a3

R10OUT TXO

T1IN
T2IN
R20UT

max3232

330—14
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xseg28 xseg18

xseg27 xseg17

pows pows

xseg25 xseg1b

1
2

X5eg26 i | xsegl6
5

Seven Segment

xseg48 xseg31

xseg47 Xseg32

pows pows

xseg4b Xseg33

xseg45 xsega4

Seven Segment

Seven Segment

E2CLK

DONEZ21

R10

7Segment & 10

1K
ARyy033

INIT19

U6

ﬁ' vee
41 vee
vce

14 1 yeco
gg VCCO
22 veco

VCCO

DONE21

NTT 9| CE
—pr5———12 OE/RESET*
L —— | B

CF*
—27 | cEO*

[ala]
ZzZ
(OO}

o
Cc3 R8
4.7u R
3.3

XC18V04PC44 (SR

T

17 |

asegii 18
S B3WIE - Mg
20|

]
— 221

F160* _23_2 4
25

FOo* 26

27

F8o o8
29
C80* 20
31
32
33
34
35
36
37
38
39

330
Lt

Jﬁ_
46 asegl7
asegi18
aseg21
asegl2

asegls
51 @aseg24

52 aseg25
aseg26
aseg27/
aseg28

asegis
57 asegi4

aseg15
59 asegib




(Spartan3) FPGA sleal o ,Se

FPGA Pin
Number

Application I

FPGA Pin
Number

Application

FPGA Pin
Number

Application

7SEG3-d

68

1016

138

ADC-DO

TXO0

71

107

139

ADC-OE

RXO0

72

1015

140

usbDO

SW1-ain4

74

106

141

usbD3

SW1-ain3

76

1014

143

usbRD

SW1-ain2

77

105

144

usbD4

SW1-ainl

78

1013

146

usbD5

RST*

79

CLKIN

147

7SEG1-g

SW2-ain8

80

1012

148

usbD6

SW2-ain7

81

103

149

7SEG1-f

SW2-ain6

85

1011

150

usbD7

SW2-ain5

86

102

152

usbTXE

SW3-ainl2

1010

154

7SEG1-a

SW3-ainll

90

101

155

7SEG2-g

SW3-ain10

93

109

156

7SEG1-b

SW3-ain9

94

D4-aled7

161

7SEG2-a

20MHZ

95

usbRXF

162

7SEG2-f

R1A0

96

D4-aled8

165

7SEG2-b

R1A1

97

D3-aled5

166

7SEG1-c

R1A2

7SEG1-e

167

usbPWREN

R1A3

D3-aled6

168

7SEG2-e

R1CSO

D2-aled3

169

7SEG2-c

R1DO

D2-aled4

171

7SEG2-d

R1D1

D4-aledl

172

usbWR

R1D2

D1-aled2

175

7SEG2-DP

R1D3

104

176

7SEG1-d

RIWE

usbRSTn

178

7SEG1-DP

R1A4

usbSIWU

180

7SEG3-a

R1A5

DAC_D2

181

7SEG4-a

R1A6

DAC_D1

182

7SEG4-g

R1A7

DAC_DO

183

7SEG4-b

R1A16

DAC_CS

184

7SEGA-f

R1A15

DAC_RW

185

usbD2

R1A14

DAC_D3

187

7SEG4-e

R1A13

DAC_D4

189

7SEG4-c

R10E

DAC_D5

190

usbD1

R1D7

DAC_D6

191

7SEG4-d

R1D6

DAC_D7

194

7SEG4-DP

R1D5

ADC-CLK

196

7SEG3-DP

R1D4

ADC-D7

197

7SEG3-c

R1A12

ADC-D6

198

7SEG3-b

R1A11

ADC-D5

199

7SEG3-g

R1A10

ADC-D4

200

7SEG3-f

R1A9

ADC-D3

203

7SEG3-e

R1A8

ADC-D2

204

SW3-ainl12

108

ADC-D1

205

usbXTIN




